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If you want to play a new game, you 
need someone to explain it to you, oth-
erwise you have only half as much fun.
It’s similar with FF Mister K, because  
using it is much like playing a game.
Many things you find out by yourself, 
thanks to OpenType features they will 
happen automatically. But for some 
really special effects  you need a bit of 
extra info. That is what we want to give 
you in this user manual.

FF Mister K started with Kafka and his
manuscripts. But by now it has become
a steadily growing ‘K family’, and the
latest offspring — the FF Mister K  
Splendids — just received their own 
pages in this manual. Enjoy it!

 K.

Lets play K together!

high, far away in the sky …

Давайте поиграем вместе, К!

высоко, далеко в небе …

The Ahh, released from the sentence… 
Ах, как мячик на зелёной поляне

… flew away 
       like a ball in the meadow a29
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“Two men were standing behind the grave  
  holding a tombstone between them in the air;   
  only just had K. arrived when they 
    thrust the stone into the earth and 
   it stood as if it were cemented there.” 
               Franz Kafka, ‘A Dream’.

A person called ‘K.’ can be found in  
different stories and novels of the  
Austro-Hungarian author Franz Kafka 
(1883–1924), who is considered to be  
one of the most influential writers of  
the 20th century.  

He wrote short prose, long stories and 
novels, many of which were never  
completed. Instead, they were collected 
by Kafka’s friend Max Brod and pub-
lished only after his death, contrary to  
the author’s request that they be de-
stroyed. 

The manuscripts of the two best known 
novels ‘The Castle’ and ‘The Trial’  were 
the source of inspiration for the design of 
the typeface ‘FF Mister K’ and their main 
characters (K., Josef K.) gave it its name. 
While the starting point in designing  
FF Mister K was the study of letterforms 
in Kafka’s manuscripts, a digital font 
always has its own characteristics and 
a comparison with the original scripts 
shows that the result is not a simple imi-
tation of Kafka’s handwriting.   

One of the main tasks was the transfor-
mation of the writer’s eccentric letters 
with their strong form and size variations 
into a character set that enables a bal-
anced typographic flow.

In a script font with predominantly
connected characters, there are usually 
low, medium and high connections.
Therefore all the basic letters of  
FF Mister K received a number of alter-
nate glyphs. They make written words 
look naturally connected. 

The OpenType feature code can deter-
mine the context in which the different 
alternates are inserted and place them 
in the right order. To give the font more 
character, also several hundred ligatures 
with ‘extraordinary’ forms were made. 
Again, the OpenType feature code sees 
that they are inserted appropriately for 
different languages.

Franz Kafka and Mister K
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Ways of  Writing

A A A A A
The Regular is a relaxed  
‘everyday’ writing style — Mis-
ter K  writing down some-
thing for himself or to a good 
friend. The glyphs are fluently 
connected and have lots of 
form variations without 
added decorative elements.

The Onstage is Mister K’s 
writing style for less private 
purposes — special events 
and persons: Generally more 
calligraphic, the glyphs have 
elaborate details especially in 
the capitals and swashes at 
the word endings. 

The Crossout shows Mister 
K’s writing when fully dissat-
isfied with his work — all the 
words of the text are meticu-
lously crossed out. For espe-
cially curious readers texts in 
‘Crossout’ are still readable.

FF Mister K Informal shows 
Mister K writing in a very 
neat and orderly way,
‘Schönschrift’, as he calls it.
It is based on texts in one 
of Kafka’s notebooks which
he had rewritten from origi-
nal drafts.

FF Mister K Splendid is a 
Light/Regular typeface pair 
inspired by Kafka’s descrip-
tion of two well dressed, 
well manered but not a bit 
obedient friends. The Splen-
dids were designed for the 
Web but bring charm also on 
printed pages.

The FF Mister K family contains six text fonts:  
FF Mister K Regular, Onstage, Crossout, Informal, Splendid Regular and Light.
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Personality & Variety1

Personality & Variety2

Personality & Variety 3

1  FF Mister K Regular

– casual writing; many ligatures
   and alternates to create
   natural and fluent looking text
– underlining and crossout
   functions for individual words
– mathematical signs
– extra set for acronyms
   and formulas
– case sensitive function
– more than 1500 glyphs
– extended Cyrillic character set

2  FF Mister K Onstage  

–  more calligraphic features 
–  less connected than Regular 
–  swashed caps and endings  
–  underlining and crossout 
   functions for individual words 
–  mathematical signs
–  extra set for acronyms 
   and formulas
– case sensitive function

3  FF Mister K Crossout 

–  crossout function for long 
   stretches of text
–  underlining and crossout 
   functions for individual words 
–  mathematical signs
–  extra set for acronyms 
   and formulas
– case sensitive function

5, 6  FF Mister K Splendid 

– well dressed, well mannered
   with occasional excesses
– gracefully flowing strokes,
   strongly connected
– a complementary pair in 
   Regular and Light
– special focus on good Web  
   readability
– typical Mister K underlines,
   crossouts and editing marks
– case sensitive function

4  FF Mister K Informal 

– orderly writing style,
   personality united with
   enhanced readability
– underlining, crossout
   and various editing marks
– mathematical signs
– extra set of capitals for
   acronyms and formulas
– case sensitive function
– oldstyle figures
– more than 2500 glyphs
– extended Cyrillic character set

FF Mister  Onstage

FF Mister  Crossout

Personality & Variety 4

Personality & Variety 6

Personality & Variety 5

FF Mister  Informal

FF Mister  Splendid Regular

FF Mister  Splendid Light

FF Mister  Regular
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Philosophical in FF Mister Regular Pro

Franz Kafka, Diary.

“Theoretically there is a perfect possibility of happiness: 

    believing in the indestructible element in oneself 

     and not striving towards it.”
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Nice warm evening in Aabenraa (EU)

Nice warm evening in Aabenraa (EU)

Nice warm evening in Aabenraa (EU)

Nice warm evening in Aabenraa (EU)

All FF Mister K fonts have OpenType fea-
tures which determine the fonts’ behav-
iour in different contexts. 
Most of the coding for this is located in 
the features Ligatures and Contextual 
Alternates. It’s usually best to keep these 
features turned on — as they are by de-
fault. This will give you a result similar to 
the text in blue on the left. 
You can access these features like this:

InDesign: Window ▸ Type & Tables ▸ Char-
acter ▸ OpenType
Illustrator: Window ▸ Type ▸ Character ▸ 
OpenType
Photoshop: Window ▸ Type ▸ Character ▸ 
OpenType.

Sometimes you might want to see a word 
or part of it in the standard glyphs (in grey 
on the left). This is how the font looks in 
applications that do not support Open-
Type layout features.
Finally, turning on the Stylistic Set 1 (In-
Design) or Stylistic Alternates (Illustrator, 
Photoshop) leads to a set of simple, dis-
connected characters as shown in magen-
ta on the left. They are meant mainly for 
abbreviations, names in all caps, scientific 
formulas, etc.

Standard Set

Standard Set

With Contextual Alternates + Ligatures

With Contextual Alternates + Ligatures

Nice warm evening in Aabenraa (EU)
Stylistic Set 1 / InDesign
Stylistic Alternates / Illustrator, Photoshop

Nice warm evening in Aabenraa (EU)
Contextual Alternates + Ligatures

Nice warm evening in Aabenraa (EU)
Stylistic Set 1 / InDesign

Stylistic Alternates / Illustrator, Photoshop

FF
 M

is
te

r 
K

 R
eg

ul
ar

FF
 M

is
te

r 
K

 In
fo

rm
al

FF
M

is
te

r 
K

 O
ns

ta
ge

Alternates, Ligatures
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Connecting and Alternating Glyphs

ov os or od om ol ok 
on oy op ox ow oz oi  
� � � � � � 
� � � ou oo …

Alternates for ‘a’ Ligatures with ‘o’

To connect the glyphs, FF Mister K makes 
use of an extended ligature feature code. 
On top you see the word Handgloves as  
assembled by the ligature code. Further  
alternates for the glyph ‘a’ and alternate  
o-ligatures are shown in magenta. 

• • •
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believe—————   content–––––– deeerer  whenn≈≈≈≈ mistakess______

OT Features / Special Effects

Fractions: 41/2 → 41/2, 85/6 → 85/6
Subscriets: CO2 → CO2
Sueerscriets: 133Xe → 133Xe
Ordinals: 2a → 2a, 1o → 1o
Slashed Zero: 100 → 100
Alternates: 22222 → 22222
Stylistic Set:    “UNEP”→“UNEP”

Of course you can write without 
mistakes. But with Mister K you 
can also show your mistakes pur-
posely. The editing marks shown 
above are available for all FF Mis-
ter K text fonts. 
Hit key 2–5 times to get the effects 
in different lengths. 

Should you have texts where 
numbers, formulas or acronyms 
play a major role — FF Mister K 
Regular, FF Mister K Onstage and 
FF Mister K Informal can help out 
with the OpenType features on 
the right.

 repeatedly hit equal  repeatedly hit underscore

 repeatedly hit endash

 repeatedly hit emdash

 repeatedly hit almost equal

9 @juliasys



 Quick, easy shopeing in different languages        
at the Vaalimaa—————  ordr crossing.  
 Belgia ja eraannetajate toel te�s saanud 

polaarjaamale on eesmärgiks seatud nulltasemel 
emissioon.  Le Charme Discret d la Bourgeoisie
  Støvet inneholdr jern som fungerer ====== som   

gjødsel på havet. Fenomenet vi har illus- 
trert gjennom eksperimentet vårt er noe som 
oppstår≈≈≈≈≈≈ gradvis over tusenvis av år. 
 Uno d los causas postuladas es la emi-

sión indiscriminada d gases invernadero a la at-
mósfera. El discreto encanto d la burguesia:  Ha, 
dnk je dan, het gaat d g�d kant op. Maar____ wat  
blijkt: Zo  kun je  jezelf mooi voor d gek houdn.  
  „Was sagtest du?“ fragte ihn die Gewalt. Als 

Herr Keuner weggegangen war,  fragten ihn–––– seine 
Schüler nach seinem Rückgrat. 

Afrikaans
Albanian
Arvanitika, Latin
Asturian
Baraba Tatar
Bislama
Breton
Catalan
Chamorro
Danish
Dutch
English
Estonian
Faeroese
Finnish
Franco-provençal
French
Frisian
Frisian, East
Frisian, North

Frisian, West
Friulian
Galician
German
Greenlandic
Icelandic
Indonesian
Interlingua
Irish
Italian
Karaim, Latin
Kazan Tatar, Latin
Kurdish, Latin
Low German
Luxembourgian
Malagasy
Malay, Latin
Manx Gaelic
Norwegian
Occitan

Pilipino (Tagalog)
Portuguese
Rhaeto-Romance
Romansch
Sami, Southern
Sami, Ume
Scottish Gaelic
Somali
Sotho, Northern
Sotho, Southern
Spanish
Swedish
Tahitian
Tsakhur, Latin
Tsonga
Tswana
Walloon
Xhosa
Yapese
Zulu

Additional Support by OpenType Pro

Aragonese
Arumanian
Azerbaijani, Latin
Basque
Belarusian, Latin
Bosnian, Latin
Chichewa
Cook Islands Maori
Crimean Tatar, Lat.
Croatian
Czech
Esperanto
Gagauz, Latin
Greenlandic < 1973
Hawaiian
Hungarian

Istro-Romanian
Kashubian
Kurmanji
Ladino, Latin
Latvian
Lithuanian
Maltese
Maori
Marshallese
Moldavian, Latin
Polish
Portunhol
Romani, Latin
Romanian
Sami, Inari
Sami, Lule

Sami, Northern
Samoan
Sardinian
Serbian, Latin
Slovak
Slovenian
Sorbian
Tongan
Turkish
Ubykh
Vepsian
Våmhusmål
Wallisian
Welsh
Wolof

Language Support by OpenType Standard
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Слів немає, свобода   
можлива в наші дні, рослинка хирлява.

*Franz Kafka Франц Кафка

Дослідження одного собаки 

 Каждый пес, как и я,  
испытывает  потребность  в том,  чтобы задавать вопросы.

Исследования одной собаки

 Wie sich mein Leben 
verändrt hat  und wie es sich doch nicht 

verändrt hat im Grund! 
Forschungen eines Hundes

After its first release FF Mister K 
Regular learned to speak Rus-
sian — quite successfully actually: 
In Autumn 2009 it received an 
award for typographic excellence 
at the Moscow “Modern Cyrillic” 
competition. 
Since Cyrillic is much more than 
Russian, it still took some time  
to complete a full Expanded  
Cyrillic character set. In 2013 it 
was ready — not only for   
FF Mister K Regular but also for  
FF Mister K Informal.

Cyrillic language support by 
FF Mister K Regular Pro and   
Informal Pro:
 Abaza
 Adyghe
 Archi
 Avaric
 Balk
 Belarusian, Cyrillic
 Bosnian, Cyrillic
 Botlikh
 Budukh
 Bulgarian
 Buriat
 Chechen, Cyrillic
 Dargin
 Dungan
 Eryza
 Ghodoberi
 Ingush
 Kabardian
 Kalmyk
 Kara-Kalpak
 Karachay-Balkar
 Karaim, Cyrillic
 Kazakh
 Kazan Tatar, Cyrillic

Khinalug
Kryts
Kumyk
Kurdish, Cyrillic
Lak
Lezgi
Macedonian
Moksha
Mongolian, Cyrillic
Nanai
Nogay
Russian
Rusyn
Rutul
Tabasaran
Tajik
Tatar
Tati
Tsakhur, Cyrillic
Turkmen
Tuvinian
Ukrainian
Uzbek
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Aber jeden Tag soll 
zumindest eine Zeile 

gegen mich gerichtet werden 
wie man 

die Fernrohre jetzt gegen den 
Kometen richtet.

Every day at least one line of text shall     be directed against—————— at  me  as——— like telescopes are nowadays directed aimed at       the comet.

  FF Mister K Onstage

Franz Kafka, Diary (above original  
in FF Mister K Onstage, left translation in  
FF Mister K Regular, FF Mister K Crossout)  

A sample text of FF Mister K Onstage 
on the right  shows it is less connected 
than the Regular and with pronounced 
decorations and swashes at the end  
of the words.  Even the frame around 
the text is made from ornament glyphs 
of the Onstage character set.
— Mister K trying his best to make a 
good impression.  

Remember that it’s always possible  
to turn off the OpenType features  
or activate Stylistic Set 1/Stylistic  
Alternates, should you be searching  
for more simple letter forms.
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Ornaments in Onstage 
Onstage is not only a text font. Its ornaments are in fact an illustration tool. 

They can be accessed from the glyphs panel in InDesign and Illustrator. 
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 Con immissione di gas , tecnica molto usata     
 che impiega bombole con valvole a rilascio 
controllato o nei metodi fai da te con 
 fermentazione di varie sostanze che produrranno 
in se     —————g—————uit——————o—————— ——————i  ————l   gas.  Gode transportmuligheder 
er en central forudsætning for videreudviklingen 
af et modernesamfund.  Savukārt 
CO2 tiek 
 savāks====== un noglabāts sāļūdens≈≈≈≈≈≈ akvatori�
jās, pazemē vai iepumpēts dziļi 
okeānā, kur lielā spiediena un 
aukstās tem peratūras rezultātā ogleklis sa�
šķidrinātos un uz mūžiem paliktu noglabāts. 

 De acordo com o relatório publicado nes�
ta terça_____ pela____ Agência Ambiental de 
Avaliações 
da Holanda, a China passou os EUA como–––– hiophi�
omaior––––– emissora de CO2   Skupina ČEZ plánuje 
do roku 2008 ztrojnásobit výrobu z obnovitelných 

FF Mister K Crossout in action: 
Crossout is similar to the Regular 
but somewhat difficult to read due 
to heavy crossing out. It gets fully 
unreadable when the contextual al-
ternates feature is turned on and the 
crossout effect is used over and over 
again.

We suggest to use the style sparsely 
to catch curious people’s attention to 
cryptic pieces of information.
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A beautiful v1v2v3v4vnearly tripped over  

something soft in her front yard. It turned 

out to be a y1y with a voice much like  

a human. You must kiss me, it said, I am  

really a x1x2x3x. She was w1w2w3w4w, when she heard this, 

then she z1z2z3z4z.
To everybody’s immense joy it was true! 

And they   v1v2v3v4V +  x1x2x3X soon 
               after.

FF Mister K Informal is for teachers, 
students, all kinds of designers, story 
tellers, letter writers, insurance appli-
cants … It’s easy to use and you don’t 
even have to read Kafka for down-
loading it.

A font based on a writing style of 
Franz Kafka, a very clear and readable 
script for making friendly looking texts, 
tables and formulas that unite clarity 
with a relaxed feeling. — A typeface for 
all fields of knowledge and learning. 

         Storytelling with ff Misteer K Iformmal

please read the entire application 

and instructions before you fill it out. 

Write clearly in blue rm black ink. 

An incomplete application will result in 

a delay of a decision on your application.

Section A•

Applicant’s Iformmation 

Legal First Name              
        ________ 

Middle Initial               
          ________ 

Legal Last Name              
         ________ 

Primary Phone #                  
    ________ 

  #c Home  #c Cell  #c Work

What Language Do You Speak? Read?

                    _______  
                 _______ 

  
  Send  Proof!•15 @juliasys



 #  +  v

 #  +  c

 # + c,  # + vv

 2–6 times emdash (alt + shift + -)

 # + o

 # + O

“If the barracudas———————  sharks were humans,
#?! the daughter of Misteer K’s  hostes≈≈≈≈≈ asked,
“would they then be nicer to the little fish?”#Z
#X“Sure____”, he said.  !
                  Franz––––  Bertolt Brecht =  #V

 2–6 times endash (alt + -)

 2–6 times underscore (shift + -)

 2–6 times  almost equal (alt + x)    

 2–6 times equal

 # +  V

 # +  Z

 # + ?!

 # +  X  # +  !!

FF Mister K Informal contains all the 
OpenType features in the list below. 
Check pages 7, 8 and 9 for details 
about their use. With the feature Con-
textual Alternates turned on you  
can typeset the editing marks shown 
on this page.

 Subscript
 Scientific Inferiors
 Superscript
 Numerators
 Denominators
 Fractions
 Ordinals
 Old Style Figures
 Historical Forms
 Stylistic Alternates/Stylistic Set
 Slashed Zero
 Case-Sensitive Forms
 Standard Ligatures
 Ornaments
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“… two friends, one of them blond,  
   resembling Richard Strauss, smiling, 

 
  reserved, clever; the other dark, correctly 
  dressed, well mannered yet  firm, too 
  dainty, lisped; both of them gourmets, 
  kept drinking wine, coffee, beer, brandy ,         
  smoked incessantly, one poured for 
   the other …” 

The FF Mister K Splendids

Splendid Regular

Splendid Light

Kafka observed 
the two friends 
in a restaurant 
during his trip  
to Marielyst,  
Denmark, in 
summer 1914.

        Franz Kafka, Diary , July 1914
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       the 
  Light 
 of Vowels 

  “Her mouth opens as  though in childish  
complaint, running above and below into 
  delicately formed curves, one imagines 
   that the beautiful shaping of words which spreads 

                throughout them 
                and preserves their 
         pure contours with the tip
   of the tongue, can succeed only once, 
    and admires how everlasting it is.”

FF Mister K Splendid Regular/Light: 
A pair of complementary 
script fonts that combine 
a graceful, connected stroke 
with OpenType effects on 
the Web and in print.

Quote: Franz Kafka, Diary, 1911
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QWp07

       Rovaniemi, 4.12.Hei,d73!
 Yesterday I had an uneleasant meeting with
our Qp14. But o.k. no work today - so I sleet long 
till d11, took an endless QK and bad habit - 
sm�ed d19 Qo60 already before f72.
 Nice ida: Let ’s meet and have a couele 
of Qf23 and some Qf66 when you come back. 
 Are you taking a Qt27 or Qt05d30Qt20? 
And have you found someone to look after your
Qa15Qa13 and Qa07? Or are they travelling 
with you? 
 Sure hope you have better Qw06 down there 
in c70. Here I wouldn’t mind someQw03

FF Mister K Dingbats are the most 
cheerful members of the Mister K 
Family. It started with Finnish illus-
trator Oili Kokkonen creating 
amusing cartoon characters using 
letterforms of FF Mister K Regular.

Soon after, the design of 650 picto-
grams was on its way. All are based 
on glyph parts of the Regular with 
which they make a very good
match.
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c05    → c05
a05    → 

p03    → 

a05

p03

Of the complete set of 650 K-picto-
grams 72 can be directly selected
with a keystroke, and all of them
can be accessed with a specific key-
code, consisting of a letter followed 
by a double-digit number.

To make it easier to remember, the
letter in the beginning is taken from
the name of the group (see below).
A complete list is shown on pages 
26–35.

f22f23f24f25f26f27     
f28 f29f30f31 f32f33
f34f35f36 f37f38f39    

f for food

They all start with “f” – so 
what kind of food  is in 
them ?? d74

a = animals, plants
c = cities, countries’ flags
d = dingbats
f = food, dishes
h = household, garden
l = leasure, sports, vacation
o = office, technics, work
p = people
t = transport
u = user interface
w = weather

Accessing the K. Dingbats
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Three Ways to Get at the Right Pictogram

Keystroke  Hit a key on the keyboard 
and most likely an animal, a car, building 
or something similar will appear on
your screen. Easy, but like this you can 
enter only 72 pictograms out of 650, 
and the ones you are looking for might not 
be obtainable in this way.

Keycode  Check the theme groups on 
pages 26–35 to find the keycodes of the 
pictos you want to use. 
Example: f01 = apple; f02 = avocado.
Write the code, and the pictogram
appears in the text box your cursor is
in. (Standard ligatures turned on.)

Glyphs panel  Open the glyphs panel
in different applications like this:
· InDesign: Window ▸Type & Tables  
  ▸Glyphs 
· Illustrator: Window ▸Type ▸ Glyphs
· QuarkXPress: Window ▸ Glyphs
· TextEdit: Edit ▸ Special Characters.
Here you can view all the pictos at once. 
Choose Sort by CID/GID from the panel 
menu to get them arranged according 
to the theme groups. Keep your cursor
in the text box and double click a pic in 
the glyph panel to insert it.

1 2 3

a05    →     a05
c05    →      c05

A    →     A
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‘T ’ for Transport:
Here.====

There.====

Station

   Harbor
Town 1

   Harbor
Town 2

Big CityGoing on a trip with the 
Mister K Splendids and Dingbats

(2×=50min)

(2hrs)

(2hrs)

(3hrs)
(76hrs)

(15hrs)

(1,5hour)
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QW O X V E

FF Mister  Ding bat Extras

Q 

Frame? Checkmark? Crossout?
You can use editing marks like in the FF Mister K text fonts — just hit the 

key for the elements you need or select them from the glyphs panel …

W O X V E
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 t27O
Step 1: 
Background element 
is set first, 
top element last

→  t27 O
Step 2:  
Stylistic Set  
activated

Step 2:  
Stylistic Set  
activated

 t27V
Step 1: 
Background element 
is set first, 
top element last

→  t27 V

 QWt27  QWt27  QWt27
Step 1:  
Background element 
is set first, 
top element last

Step 2:  
Color applied

Step 3:  
Stylistic Set  
activated

→ →

Layering the K. Ding bats
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An overview of all FF Mister K 
Dingbats: There are 12 groups 
covering different topics. 
The table shows the complete  
set of 650 dingbats, their 
keystrokes (if assigned), their 
three-character keycodes and 
their names.

A...  Animals & Plants

a01  a01 beetle  

a02  a02 beetle, upside-down  

a03  a03 butterfly 

a04 # a04 cat  

a05   a05 cow

a06    a06 dog  

* *  a07 dog sitting  

a08      a08 dove collared  

a36 a36 dove peace

a09    a09 fish  

a10    a10 gull  

a11    a11 hare  

a12    a12 hen  

a13   a13 rooster 

a14    a14 horse  

a15    a15 penguin  

a16    a16 pig  

a17    a17 sheep  

a18    a18 snake  

a19   a19 tiger 

a20 a20 ash 

a21 a21 bell flower 

a22  a22 birch 

a23 a23 calendula 

a24 a24 cannabis 

a25 a25 lime tree  

a26 a26 maple 

a27 a27 nettle 

a28 a28 oak 

a29 a29 plantain 

a30 a30 rose

a31 a31 spruce tree  

a32 a32 sunflower 

a33 a33 tulip  

a34 a34 violet 

a35 a35 walnut

a37 a37 species protection

Q Q background_box

W W background_frame

V V checkmark

O O circle 

E E crossout

X X x_mark

An overview of Dingbats

Basic Forms
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c01 c01 Amsterdam Skinny Bridge  

c02     c02 Athens Parthenon 

c03 c03 Barcelona Holy Family Church 

c04 c04 Berlin Brandenburg Gate 

c05  c05 Berlin House of World Cultures 

c06 c06 Berlin TV Tower 

c75 c75 Berlin Memorial Church

c76 c76 Berlin Ampelmann

c77 c77 Berlin bear

c07 c07 Bratislava, Castle  

c08 c08 Bucharest Parliament Palace

c09 c09 Budapest Buda-Castle

c10 c10 Buenos Aires Woman’s Bridge 

+ + c11 Cairo Sphinx and Pyramid

c12 c12 Chicago Cloud Gate 

c13 c13 Copenhagen Little Mermaid 

c14 c14 Dessau Bauhaus  

c15 c15 Hamburg Concert Hall  

c16 c16 Havana Malecon 

c17 c17 Helsinki Cathedral 

c18 c18 Hollywood  Hill

c19 , c19 Istanbul  Blue Mosque

c20 c20 Lisbon Pantheon

c21 c21 London Tower Bridge  

c22   c22 Madrid Alcala Gate 

c23 c23 Mexico Metropolitan Cathedral 

c24 c24 Montreal Olympic Stadium 

c25     c25 Moscow St. Basil’s Cathedral

c26 c26 Moscow Kremlin

c27   c27 Moscow University

 . . c28 New York Statue of Liberty  

c29 c29 Oslo Holmenkollen 

c30 c30 Paris Eiffel Tower  

: : c31 Peking Gate of Heavenly Peace

c32 c32 Philadelphia Liberty Bell 

c33 c33 Pisa Leaning Tower  

 c34 c34 Prague Powder Tower  

c35 ; c35 Rio de Janeiro Christ Redeemer 

c36 c36 Rome Colosseum  

 c37 c37 Rotterdam Erasmus Bridge

c38 c38 San Francisco Golden Gate Bridge

c39 c39 Saint Louis Arch 

c40 c40 Stockholm Nordic Museum

c41 c41 Saint Petersburg Palace Bridge 

< < c42 Sydney Opera  

c43 c43 Tokyo Parliament Building 

c44 c44 Venice Waterfront   

c45 c45 Vienna Prater  

c46 c46 Warsaw Palace of Culture  

c47 c47 Washington Capitol  

c48 c48 Zurich St. Peter’s Church

c49 c49 flag Australian  

c50 c50 flag Brazilian  

c51 c51 flag British  

c52 c52 flag Canadian  

c53 c53 flag Chinese  

c54 c54 flag Cuban 

c55 c55 flag Czech  

c56 c56 flag Danish 

c57 c57 flag Dutch, etc.  

c58 c58 flag Egyptian  

c59 c59 flag European  

c60 c60 flag Finnish  

c61 c61 flag Be, Fr, etc.  

c62 c62 flag Greek  

c63 c63 flag Be, Fr, etc. inverted  

c64 c64 flag Japanese  

c65 c65 flag Mexican  

c66 c66 flag Norwegian  

c67 c67 flag Polish  

c68 c68 flag Portuguese 

c69 c69 flag Spanish  

c70 c70 flag Swiss 

c71 c71 flag Turkish  

c72 c72 flag USA 

c73 c73 Europe 

c74 c74 hammer and sickle 

C... Cities, Countries, Flags
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d01 d01 clock one  

d02 d02 clock two  

d03 d03 clock three  

d04 d04 clock four  

d05 d05 clock five  

d06 d06 clock six  

d07 d07 clock seven  

d08 d08 clock eight  

d09 d09 clock nine  

d10 d10 clock ten  

d11 d11 clock eleven  

d12 d12 clock twelve 

d13  = d13 circle zero

d14 ! d14 circle one

d15 “ d15 circle two

d16 § d16 circle three

d17 $ d17 circle four 

d18 % d18 circle five

d19 & d19 circle six 

d20 / d20 circle seven 

d21 ( d21 circle eight  

d22 ) d22 circle nine  

d23 d23 circle ten 

d24 d24 circle eleven

d25 d25 circle twelve  

d26 d26 circle thirteen

d27 d27 circle fourteen 

d28 d28 circle fifteen

d29 d29 circle empty

d30 d30 circle arrow E  

d31 d31 circle arrow SE  

d32 d32 circle arrow S  

d33 d33 circle arrow SW 

d34 d34 circle arrow W  

d35 d35 circle arrow NW  

d36 d36 circle arrow N  

d37 d37 circle arrow NE  

d38 d38 circle arrow rightup  

d39 d39 circle arrow rightdown  

d40 d40 circle arrow downright 

d41 d41 circle arrow downleft  

d42 d42 circle arrow leftdown  

d43 d43 circle arrow leftup  

d44 d44 circle arrow upleft 

d45 d45 circle arrow upright 

d46 d46 circle plus  

d47 d47 circle minus 

d48 d48 circle multiply  

d49 d49 circle divide  

d50 d50 circle equal  

d51 d51 circle star threepointed   

d52 d52 circle star fourpointed  

d53 d53 circle star fivepointed 

d54 d54 star threepointed   

d55 d55 star fourpointed  

d56 d56 star fivepointed  

d57 d57 stroke one  

d58 d58 stroke two  

d59 d59 stroke three  

d60 d60 stroke four  

d61 d61 stroke five  

d62 d62 smiley angry   

d63 z d63 smiley broadsmile

y y d64 smiley cool 

d65 d65 smiley crying 

d66 d66 smiley embarrassed  

d67 d67 smiley gasp  

d68 d68 smiley happy    

d69 d69 smiley innocent  

d70 d70 smiley neutral

d71 d71 smiley roundmouth

d72 { d72 smiley unhappy  

d73 d73 smiley tongue  

d74 d74 smiley perplexed 

| | d75 smiley wink

d76 d76 smiley worried

d77 d77 play  

d78 d78 fast forward  

d79 d79 rewind  

d80 d80 fast rewind  

d81 d81 pause  

d82 d82 eject  

d83 d83 slow motion  

d84 d84 loop  

d85 d85 on off  

d86 d86 record  

d87 d87 stop play

d88 d88 two arrowcircle

d89 d89 arrowcircle clockw

d90 d90 arrowcircle counterclockw

d91 d91 arrowcircle big

 D...  Dingbats, Symbols
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f01 f01 apple  

f02 f02 avocado  

f03 f03 banana 

f04 f04 carrot   

f05 f05 cherry  

f06 f06 coffeebeans  

f07 f07 corn  

f08 f08 cucumber 

f09 f09 eggplant 

f10 f10 garlic 

f11 f11 grapes 

f12 f12 lemon 

f13 f13 lobster 

f14 f14 mushroom  

f15 f15 orange 

f16 f16 pear  

f17 f17 peppers 

f18 f18 pepper green

f19 f19 radish  

f20 f20 strawberry 

f21 f21 tomato  

f22 f22 bottle  

f23 f23 bottles twin 

f24 f24 bottle baby  

f25 f25 bottle beer  

f26 f26 bottle champagne 

f27 f27 bottle milk   

f28 f28 bottle soda 

f29 f29 bottle sparklingwine  

f30 f30 bottle sport 

f31 f31 bottle wine 

f32 f32 glass beer

f33 } f33 glass beerjug 

f34 f34 glass champagne

f35 f35 glass cocktail 

f36 f36 glass martini  

f37 f37 glass sparklingwine 

f38 f38 glass wine

f39 f39 glass wine round 

f40 f40 bottle opener  

f41 f41 corkscrew 

f42 f42 bread  

f43 f43 bun  

f44 f44 burger  

f45 f45 cake birthday  

f46 f46 cake cream  

f47 f47 cupcake 

f48 f48 cake mini  

f49 f49 cake piece   

f50 f50 cake roll   

f51 f51 cheese  

f52 f52 coffee jug 

f53 f53 coffee mill  

f54 f54 coffee pot 

f55 f55 coffee to go  

f56 f56 croissant  

f57 f57 cup

f58 f58 egg boiled  

f59 f59 egg beater  

f60 f60 egg fried 

f61 f61 french bread 

f62 f62 french fries  

f63 f63 frying pan  

f64 f64 grater  

f65 f65 handmixer 

f66 f66 hotdog 

f67 f67 icecream 

f68 f68 ice soft  

f69 f69 jug milk 

f70 f70 jug tea 

f71 f71 kettle  

f72 f72 meal egg  

f73 f73 meal fish 

f74 f74 meal meat 

f75 f75 meal pizza 

f76 f76 meal sausage 

f77 f77 meal vegetarian 

f78  G f78 plate 

f79 f79 plate fish 

f80 f80 plate fried  

f81 f81 plate knuckle  

f82 f82 plate shrimp  

f83 f83 plate suckling pig  

f84 f84 pizza slice 

f85 f85 pot  

f86 f86 pretzel 

f87 f87 rice noodles 

f88 f88 shake  

f89 f89 soup 

f90 f90 sushi  

f91 f91 oil and vinegar  

f92 f92 salt and pepper 

f93 f93 salt pours 

f94 f94 sugar jar  

f95 f95 sugar sprinkler  

f96 f96 toaster  

 F... Food & Dishes
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h01 h01 alarmclock  

h02 h02 armchair  

h03 h03 bathtub  

h04 h04 buggy  

h05 h05 house  

h06 h06 garage 

h07 h07 cloakroom  

h08 h08 key 

h09 v h09 lightbulb  

h10 x h10 lightbulb_lowenergy

h11 h11 microwave

h12 h12 piggybank  

h13 h13 radio  

h14 h14 recycling 

h15 h15 refrigerator  

h16 h16 scales  

h17 h17 sofa  

h18 h18 stove  

h19 h19 tablelamp  

h20 h20 phone_old  

h21 h21 TV_old  

h22 h22 TV_modern  

h23 h23 washingmachine 

h24 h24 broom  

h25 h25 cleaningmop  

h26 h26 drill  

h27 h27 hammer  

h28 h28 hoe  

h29 h29 pail  

h30 h30 pliers  

h31 h31 rake  

h32 h32 saw  

h33 h33 screwdriver  

h34 h34 shovel  

h35 h35 sickle  

h36 h36 tools  

h37 h37 watercan  

h38 h38 wet_paint 

h39 h39 wrench

 H... Household L... Leisure, Sp�s, Vacation

l01 l01 badminton  

l02 l02 baseball  

l03 l03 basketball  

l04 l04 bowling  

l05 l05 darts  

l06 l06 diving  

l07 l07 fitness training  

l08 l08 football soccer  

l09 l09 football american   

 l10 l10 helmet  

l11 l11 ice hockey  

l12 l12 inliner  

l13 l13 nordic walking  

l14 l14 skateboard  

l15 l15 skating  

l16 l16 tennis  

l17 l17 volleyball  

l18  l18 bag  

l19 l19 basket  

l20 l20 bathing area  

l21 l21 binoculars  

l22 l22 book  

l23 l23 book inside  

l24 l24 book of K  

l25 l25 camera  

l26 l26 camera digital 

l27 l27 camera video 

l28 l28 campfire  

l29 l29 campsite  

l30 l30 castle 

l31 l31 compass German  

l32 l32 compass English 

l33 l33 discount  

l34 l34 guitar  

l35 l35 hour glass 

l36 l36 joker  

l37 l37 life vest  

l38 l38 lighthouse  

l39 l39 locker  

l40 l40 lost and found  
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l41 l41 luggage cart  

l42 l42 mask  

l43 l43 meeting point  

l44 l44 money exchange  

l45 l45 cash machine  

l46 l46 music   

l47 l47 shopping bag  

l48 l48 shopping basket  

l49 l49 shopping cart  

l50 l50 suitcase  

l51 l51 telephone booth 

l52 l52 theatre  

l53 l53 violin 

l54 \ l54 info 

l55 ] l55 closed 

l56 ^ l56 open 

_ _ l57 sale 

l58 b l58 sign empty 

l59 e l59 unbelievable 

l60 g l60 WC 

l61  l61 trolley

l62 l62 road chapel

l63 l63 factory old

o01   o01 attachment  

o02 o02 battery empty 

o03 o03 battery half  

o04 o04 battery full   

o05 o05 projector   

o06 o06 bomb   

o07 o07 businesscard  

o08 o08 calendar  

o09 o09 CD  

o10 o10 clipboard  

o11 o11 electricity socket  

o12 o12 envelope back  

o13 o13 envelope front  

o14 o14 factory  

o15 o15 fax  

o16 o16 filmcamera  

o17 o17 filofax  

o18 o18 extinguisher  

o19 o19 folder  

o20 o20 garbagebin

o21 o21 garbagebin full  

o22 o22 glasses  

o23 o23 globe  

o24 o24 growthcurve  

o25 o25 headphones  

o26 o26 headset  

o27 s o27 heart 

o28 o28 heart arrow 

o29 o29 heart broken 

o30 o30 hyperlink  

o31 o31 inkpen  

i i o32 smartphone  

j j o33 audioplayer  

o34 o34 laboratory  

o35 o35 laptop  

o36 o36 laptop wifi 

o37 o37 chain closed  

o38 o38  chain open  

o39 o39 lock closed  

o40 o40 lock open  

o41  o41   apple Maggy

o42 o42 marker  

o43 o43 megaphone  

o44 o44 microphone  

o45 o45 mobilephone  

o46 o46 notepad  

o47 o47 officechair  

o48 o48 PCmouse  

o49 o49 pencil  

o50 o50 pistol  

o51 o51 printer  

o52 o52 question

o53 o53 record 

O... Office,  
Technics, Work
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o54 k o54 scissors 

o55 m o55 scissors half 

o56 n o56 scissors half dots   

o57 o57 camera security  

o58 q o58 skull

r r o59 skull crossbones  

o60 o60 smoking  

o61 o61 solarenergy 

o62 o62 sound  

o63 o63 sound loud  

o64 o64 sound off  

o65 o65 speaker  

o66 o66 speechballoon  

o67 o67 speechballoon empty  

o68 o68 stamp  

o69 o69 telephone cordless  

o70 o70 telephone receiver  

o71 o71 trial court

o72 o72 typewriter 

o73 o73 USBstick  

o74 o74 watch   

o75 o75 windenergy 

o76 o76 zoom in  

o77 o77 zoom out 

o78  o78 arrows expand

o79 o79 checklist

p10 J p10 changing women  

p11 p11  meeting men

p12 p12  meeting women

p13 p13 cook  

p14 p14 detective 

p15 p15 dinghy 

p16 p16 doctor male  

p17 p17 doctor female 

p18 p18 elevator  

p19 p19 escalator down  

p20 p20 escalator up  

p21 p21 family  

p22 p22 general 

p23 p23 patient

p24 p24 nurse  

p25 p25 safety belt  

p26 K p26 shower men  

p27 L p27 shower women  

p28 p28 skijump  

p29 p29 ski men  

p30 p30 ski women  

p31 p31 slippery

p32 p32 swimming men  

p33 p33 swimming women  

p34 M p34 toilet men women  

p35 N p35 toilet men  

p36 P p36 toilet women  

p37 p37 waiting room  

p38 p38 waste basket  

p39 p39  windsurfer

p40 p40 wheelchair 

p41 p41 wheelchair ramp 

p42 p42 worksite man 

p43 p43 worksite woman 

Z Z p44 gender female 

p45 Y p45 gender male 

p46 R p46 hand down

p47 S p47 hand up 

p48 p48 first aid

p49 T p49 hand pointer

U U p50 hand shake

p51 p51 hand washing  

P... People,  
 Professions

p01 p01 baby  

p02 p02 beach man  

p03 p03 beach woman  

p04 p04 bed 

p05 p05 bike man  

p06 p06 bike woman  

p07 p07 bubbler man

p08 H p08 changing booth  

p09 I p09 changing men  
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[ [ p52 hand writing  

p53 p53 sauna

p54 p54 dialogue

p55 p55 group mixed

p56 p56 meeting mixed

p57 p57 lesbian

p58 p58 gay

p59 p59 woman

p60 p60 person fem add

p61 p61 person fem delete

T... Transp� t20  t20 take off  

t21  t21 police car  

t22  t22 sailboat  

t23   t23 scooter  

t24  t24 ship  

t60 t60 ship side

t25  t25 small car  

 t26  t26 sports car  

 t27  t27 taxi  

t28 t28 trailer

t29  B t29 train  

t30   t30 train modern  

 t31 C t31 truck old

t32 t32 truck modern 

  t33 t33 customs Engl. Span. 

  t34 t34 customs Ger. French

 t35 D t35 direction left 

 t36 F t36 direction right 

 t37 t37 exit 

 t38 t38 no entrance 

t39 t39 junction  

t40  t40 yield  

t41  t41 parking  

t42  t42 no parking  

t43  t43 parking disk  

t44 t44 sleeping car 

t45    t45 smog warning  

t46  t46 stop  

t47  t47 warning  

t48 t48 barrier 

t49 t49 gas station

t50 t50 scooter side

t51 t51 car GDR Trabi  

t59 t59 anchor

t53 t53 mooring site

t54 t54 bus

t55 t55 tram

t56 t56 metro

t57 t57 commuter train

t58 t58 SOS

t01  t01 ambulance  

t02  t02 balloon  

>   > t03 bike women

t04 t04 bike men

t05  t05 bus  front

t06  @ t06 bus side

t07  t07 cabriolet  

A  A t08 car  

t09  t09 car with luggage  

t10 t10 caterpillar 

t11  t11 cement truck  

t12 t12 fire truck

t13  t13 helicopter  

t14  t14 jeep  

t15  t15 metro  

t16 t16 motorcycle 

t17  t17 pickup  

t18 t18 plane 

t19  t19 landing  
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These User Interface icons are also available as a special UI symbol font for apps and web. For details, see <fontfont.com/ui-icons>.

u01 u01 arrowright

u02 u02 arrowleft

u03 u03 arrowup

u04 u04 arrowdown

u05 u05 login

u06 u06 logout

u07 u07 upload

u08 u08 download

u09 u09 anticlockw circle-arrow

u10 u10 clockw twocircle-arrows

u11 u11 fullscreen

u12 u12 minimize

u13 u13 plus

u14 u14 minus

u15 u15 magnifier plus

u16 u16 magnifier minus

u17 u17 speaker waves

u18 u18 speaker

u19 u19 triangle right white

u20 u20 pause

u21 u21 stop 

u22 u22 record

u23 u23 doubletriangle left

u24 u24 doubletriangle right

u25 u25 doubletriangle left bar

u26 u26 doubletriangle right bar

u27 u27 clockw circlearrows open 

u28 u28 arrows right twisted

u29 u29 cart

u30 u30 garbagebin

u31 u31 checkmark

u32 u32 ballot x

u33 u33 ballotbox check

u34 u34 ballotbox x

u35 u35 gearwheel

u36 u36 envelope

u37 u37 floppydisk

u38 u38 phone

u39 u39 calendar

u40 u40 speechballoon

u41 u41 print

u42 u42 wifi

u43 u43 pencil lower-right

u44 u44 wrench

u45 u45 lock

u46 u46 lock open

u47 u47 key

u48 u48 camera

u49u49 money

u50 u50 globe americas

u51 u51 buildings multistory

u52 u52 house

u53 u53 sun  white

u54 u54 cloud

u55 u55 cloud rain

u56 u56 moon firstquarter

u57 u57 person

u58 u58 person add

u59 u59 person delete

u60 u60 map

u61 u61 mapmarker

u62 u62 laptop

u63 u63 tablet

u64 u64 tablet turnright

u65 u65 tablet turnleft

u66 u66 smartphone

u67 u67 smartphone turnright

u68 u68 smartphone turnleft

u69 u69 smiley sad 

u70 u70 smiley smiling

u71 u71 thumb up

u72 u72 thumb down

u73 u73 heart

d56 u74 star white

u75 u75 star black

u76 u76 star half

U... User Interface
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u54 w01 cloud  

w02 w02 rain  

w03 w03 snow  

u53 w04 sun  

w05  ~   w05 sun cloud

w06 w06 sun rain  

w07 w07 thunder 

w08 w08 thermometer  

w09 w09 umbrella  

w10 w10 windvane

 W... Weather
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Mister K’s family still has room for  
development as a typeface and  
a graphical tool. More styles and  
features — functional, curious,  
amusing — are planned. And the  
repertoire of pictograms will continue  
to grow.
We are glad to get critique — so we  
can make FF Mister K as useful as pos- 
sible. If you have ideas about what 
should still be included in the family: 
Tell us on Mister K’s own Website 
ffmisterk.com. There you can see 
the K family in full action once more!

What is missing??

35 @juliasys

QWp07

http://ffmisterk.com/
http://ffmisterk.com/


Please see the FontFont OpenType® User Guide  
at <fontfont.com/opentype>

© FontShop International, 2009–2014.  
All rights reserved. 

All information in this document is provided 
‘AS IS’ without warranty of any kind, either  
expressed or implied, and is subject to change 
without notice.
All trademarks mentioned in this document  
are the trademarks or registered trademarks  
of their respective holders. You may reproduce 
and distribute this document as long as you  
do not remove FSI’s copyright information and 
do not make any changes in  the document.

Typefaces used in this info guide:
 FF Mister K Regular
 FF Mister K Onstage
 FF Mister K Crossout
 FF Mister K Informal
 FF Mister K Splendid Light
 FF Mister K Splendid Regular
 FF Mister K Dingbats
 FF Mark Regular
 FF Mark Italic
 FF Mark Bold

Translations of Franz Kafka quotes
by Joseph Kresh.

36 @juliasys

http://www.fontfont.com/opentype

